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Overview 

Introduction to In the Cloud: File Storage Collaboration and Communication with 

Office 365 

Learning is more powerful in the classroom with the same suite of tools that the business world has come 

to expect for effective communication and collaboration. 

Office 365 provides access to familiar Office tools virtually anywhere – including free email, shared team 

sites, online document editing and storage, instant messaging, and video conferencing for students, 

faculty, and staff. In this training, educators will learn how Lync provides a media for meeting virtually: for 

parent conferences, for team or student meetings, or to just touch base with struggling students. They will 

also learn time-saving ways to make Outlook and Calendar work for them; as well as strategies for staying 

organized, sharing files easily, and using OneDrive’s Office Web Apps. 

This six-hour Academy allows educator participants to take a deep dive into cloud-based tools for the 

classroom, with a special focus on topics such as file storage, collaboration and communication using 

Office 365. It will also give educators the opportunity to apply their learning towards the end of each part 

of the session – reflecting on the topics covered, as well as strategizing on how they can be put to the 

best use in the classroom or with other educators. 

The session will culminate with educators feeling comfortable and knowledgeable about how they can 

bring cloud-based tools into classrooms in a way that truly enables students and educators to collaborate, 

communicate, store and share documents and files. 

How to use this guide and conduct the Teacher Academy 

This six-hour session is designed for presenting to groups of educators, varying in size (with a 

recommended maximum of 25). 

This trainer guide walks the trainer through the setup and delivery of a Teacher Academy. It is intended to 

provide all the information you need to confidently lead the training. Here are some tips to help make 

your training session as effective as possible: 

 Table of Contents – Navigate this guide more easily using the Table of Contents above. 

 Academy Outline – This guide can be used as a “cheat sheet” when you are conducting the 

Academy to help you remember the order and timing of topics to be covered. 

 Preparation – Be sure to set up the necessary equipment in advance so that it’s ready for  

your session. 

 Timing – The actual amount of time it takes to conduct this session will vary depending on the 

knowledge level and learning style of the participant(s). Be prepared to make adjustments on the 

fly, using the time estimates provided in the document as a guide. Six hours have been scheduled 

for this Teacher Academy. Make sure you have enough time for the Parking Lot questions section 

at the end. 
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Academy Session Objectives 

By the end of this session, participants will be able to: 

 Login and setup a profile in Outlook, as well as use various other Outlook features. 

 Login and access OneDrive for Business & Office Online, create and share a file on OneDrive for 

Business & Office Online, and use other OneDrive features. 

 Setup their Lync profile and audio settings, and make and accept a call using Lync. 

 Setup Lync contacts and distribution lists, connect with another attendee via Lync, share and 

record content, and use other applications with Lync. 

 Login and setup a Yammer profile, post an introduction in a Yammer group, and learn how to use 

other features. 

The Trainer’s Role 

The trainer’s role is to motivate educators and help them get the most from the activities provided. 

Learning will only be embedded once ideas and activities are put into practice. Facilitation should model 

the same approaches to teaching and learning that it aims to develop. Educators who develop awareness 

and understanding of their own learning as they progress can apply this knowledge more confidently. 

Such a reflective dimension might also help support their students in developing an understanding and 

awareness of their own learning, thus modelling effective aspects of teaching and learning as an integral 

part of the course design and pedagogy. 

Target Audience Guidance 

The primary audience for this session is educators who are interested in using the same suite of tools with 

their students and other educators that the business world has come to expect for effective 

communication and collaboration. 

It is invaluable for anyone eager to learn how they can enable students and other educators to work more 

effectively with the cloud-based tools of Office 365. 

Recommended size for this Academy is 25 educators with one trainer. 

Length  

Six-hours 
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Materials and Supplies 

Important Before-Training Notes on Setup, Software and Accounts 

 Office 365: It is critical that the district/school has setup Office 365 accounts and given access  

to all users. 

 OneDrive for Business: A portion of the training is dedicated to using OneDrive for Business 

which is a file storage resource in Office 365. 

o The district/school should carefully pre-plan the best way to use this storage resource. 

o Also, the success of this training relies heavily on the district/school creating a process that 

is efficient and effective for their own unique purposes. 

 Outlook: This academy provides Outlook online training, but does not cover Outlook 2013 

desktop or Outlook for mobile devices. 

 Yammer: Although it is not a significant portion of the training, Yammer is included. It should be 

setup prior to the training. 

 Lync: This training also has a Lync component, which must be installed on all training devices. 

Note:  OneDrive vs Team sites requires a lot more planning for most and you will want to have 

stakeholders involved. Team sites are not covered in this training. For resources, go to 

http://fasttrack.office.com/ 

Equipment 

 Screen display for trainer. 

 Windows 8.1 device (i.e. Surface Pro, tablet, laptop or desktop PC) for trainer. 

 All participants should have a Windows 7, Windows 8 or Windows 8.1 device (i.e. Surface Pro, 

laptop, tablet or desktop PC). Request participants to share devices if applicable. There should not 

be more than two participants per device. 

 Webcams and headsets with microphones (for the Lync and Yammer sections). 

Software/Applications 

 Microsoft Office 365 (Lync, Outlook, OneDrive for Business) 

 Yammer 

 Bing/Internet Explorer 

Materials 

 Teacher Academy Outlines/Trainer Guide and support presentation for trainer. 

 Participant Handbook for participants. 

http://fasttrack.office.com/
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Academy Outline 

Use the outline below as a “cheat sheet” when conducting the session. 

Note:  You should give participants a 30 minute lunch break at approximately 11:30 or 12, preferably 

positioning it after the Office Online & OneDrive for Business section. Also, the (green) start times listed in 

this trainer guide are based on a 15 minute break after the Office Online section. Plan accordingly, and 

make the necessary adjustments to timing to accommodate this. The break is included in this six-hour 

Academy, but the lunch is not taken into consideration. 

Elapsed 

time 

(min) 

Time 

(min) 
Topic Description 

Section #1: Introduction (5 minutes) 

:00 1 Welcome (15 minutes before class, display Slide 1.) 

Introduce yourself. 

Introduce the In the Cloud: File Storage Collaboration 

and Communication with Office 365 – Teacher Academy, 

with the supporting PowerPoint presentation. 

:01 1 Logistics Review session housekeeping items. 

:02 3 Teacher Academy Overview Overview the session. 

Section #2: Outlook (1 hour, 30 minutes) 

:05 5 Introduction Introduce Outlook and discuss the features that  

are available, starting with the high-level learning 

objectives that will be covered. 

:10 70 Demonstration Demonstrate how to use Outlook from Office 365. 

Switch from PowerPoint to your own computer to 

conduct a hands-on Outlook demonstration. 

1:20 5 Turn and Talk In groups of two or three, have participants turn to each 

other and discuss their ideas for what implementation 

and integration of Outlook would mean for their school 

or district. 

Promote ideas such as: 

 Collaboration: How will Outlook promote 

collaboration? 

 Decision Making: How will Outlook be used in 

your district/school? 

 Planning: Careful planning is essential when 

training. What will you take into consideration 

as you train on Outlook? 
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Elapsed 

time 

(min) 

Time 

(min) 
Topic Description 

1:25 10 Share Have one or two people share which features from  

this training session they are most excited about using 

in Outlook.  

Section #3: Office Online (1 hour, 30 minutes) 

1:35 5 Introduction Introduce OneDrive for Business & Office Online, and 

discuss the features that are available. 

1:40 70 Demonstration Demonstrate how to use OneDrive for Business & Office 

Online from Office 365. 

Switch from PowerPoint to your own computer to 

conduct hands-on demonstrations of OneDrive for 

Business & Office Online. 

2:50 5 Turn and Talk In groups of two or three, have participants turn to each 

other and discuss their ideas for what implementation 

and integration of OneDrive for Business & Office 

Online would mean for their school or district. 

Promote ideas such as: 

 Collaboration: How will OneDrive for Business 

& Office Online promote collaboration? 

 Decision Making: How will OneDrive for 

Business & Office Online be used in your 

district/school? 

 Planning: Careful planning is essential when 

training. What will you take into consideration 

as you train on OneDrive for Business &  

Office Online? 

2:55 10 Share Have one or two people share which features from this 

training session they are most excited about using in 

OneDrive for Business & Office Online. 

Break (15 minutes) Recommended Here 

Section #4: Lync (1 hour, 30 minutes) 

3:20 5 Introduction to Lync Introduce Lync using this video. 

3:25 70 Demonstration Switch from PowerPoint to your own computer to 

conduct a hands-on demonstration of Lync. 

http://go.microsoft.com/fwlink/p/?LinkId=272450
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Elapsed 

time 

(min) 

Time 

(min) 
Topic Description 

4:35 5 Turn and Talk In groups of two or three, have participants turn to each 

other and discuss their ideas for what implementation 

and integration of Lync would mean for their school  

or district. 

Promote ideas such as: 

 Collaboration: How will Lync promote 

collaboration? 

 Decision Making: How will Lync be used in 

your district/school? 

 Planning: Careful planning is essential when 

training. What will you take into consideration 

as you train on Lync? 

4:40 10 Share Have one or two people share which features from  

this training session they are most excited about using 

in Lync. 

Section #5: Yammer (1 hour, 5 minutes) 

4:50 5 Introduction to Yammer Introduce Yammer and discuss the features that are 

currently available, as well as those coming soon. 

4:55 45 Demonstration Demonstrate how to use Yammer, switching from 

PowerPoint to your own computer to conduct hands-on 

demonstrations of Yammer. 

5:40 5 Turn and Talk In groups of two or three, have participants turn to each 

other and discuss their ideas for what implementation 

and integration of Yammer would mean for their school 

or district. 

Promote ideas such as: 

 Collaboration: How will Yammer promote 

collaboration? 

 Decision Making: How will Yammer be used in 

your district/school? 

 Planning: Careful planning is essential when 

training. What will you take into consideration 

as you train on Yammer? 

How could Yammer be used in classrooms? 

5:45 10 Share Have one or two people share which features from  

this training session they are most excited about using 

in Yammer. 
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Elapsed 

time 

(min) 

Time 

(min) 
Topic Description 

Section #6: Closing (5 minutes) 

5:55 3 Q&A Answer participant questions. 

5:58 2 Promote Additional Learnings Discuss any other Teacher Academies that may  

be available. 
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Conducting the Session 

Section #1: Introduction (7 minutes) 

Objectives: 

 Welcome participants 

 Discuss logistics and session “housekeeping” items 

 Create Academy teams 

 Provide a quick overview of session 

15 Minutes Before Academy Starts 

Display Slide 1: Teacher Academy – We are partners in learning 

Welcome 

Display Slide 2: Teacher Academy – In the Cloud: File Storage, Collaboration and Communication with 

Office 365 

Introduce yourself: Tell participants who you are and thank them for coming. Show genuine excitement 

for having them attend the Academy.  

Say: This Teacher Academy focuses on ways you can use cloud-based products and services to enable 

you to store and share files, as well as to collaborate and communicate more effectively in the 

classroom, bringing more satisfaction to you as an educator and to your students as learners. The next 

six hours will be focused on you becoming more comfortable with tools like Office 365, OneDrive for 

Business and Outlook, and you will walk away with thoughts and strategies on how you can enable 

both your students and other educators to create more dynamic learning in the classroom. 

Ask:  Ask about their experience with cloud-based tools, and what they expect from the session. 

Logistics and Session “Housekeeping” Items 

 Six-hour Teacher Academy 

 15 minute break approximately half-way through, and a 30 minute lunch break 

 Restroom locations 

 Courtesy cell phone silence 

Teacher Academy Overview  

Say: It’s always better to be able to practice what you learn, so while I’m going to demonstrate a few 

things, you’ll also be working with the tools that I’ll be using. 

Display Slide 3: Objectives 

Say: This Teacher Academy is designed to give you some ideas on how you can be innovative with 

cloud-based tools, such as those offered in Office 365. 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 
Start at 

:02 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 

Start at 

:03 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 



 

 

 In the Cloud: File Storage Collaboration and Communication with Office 365 – Teacher Academy 12 

Rev. 04/21/2014 

 

 

First, we’ll jump into Outlook, show you around, help you setup a profile, and then use other features 

available in Outlook. 

After that, you’ll have the chance to work in Office and OneDrive for Business – where you’ll login, 

access OneDrive and Office, create and share files, and use other features available. 

We’ll take a 15-minute break after that. We’ve got a lot to cover, so it will be a short one. 

The rest of the day will focus on Lync and Yammer. With Lync, you’ll again have the chance to setup a 

profile, make and accept a call, share and record content, work with contacts and distribution lists, and 

learn about other features. Finally, you’ll get setup with Yammer, post a group introduction and learn 

about other features. 

Along the way, we may need to create a “parking lot” for some of your questions, so we can address 

them at an appropriate time along the way, or towards the end of the session during Q&A. 

You’ll be able to take notes in the handbook we’re providing. The handbook also contains some good 

reference information from today’s session. Feel free to add to it whenever necessary, as it follows 

along with the topics we’re presenting today. 

This will be both a fun and informative session for everyone. 

Any questions? 

Let’s get started! 

Section #2: Outlook (1 hour, 30 minutes) 

Objectives: 

 Introduce Outlook and discuss the features that are available 

 Give participants the opportunity to discuss and strategize on how Outlook could be integrated 

and implemented at their school or district 

Outlook Introduction 

Display Slide 4: Office 365 & Outlook 

Say: Let’s get started with Outlook! During the majority of this Academy, you will want to follow along 

on your computer with what we cover. Feel free to ask questions along the way, and as mentioned,  

I may “park” some of the questions in the parking lot for us to cover later in the session, or during  

the Q&A. 

Note:  Before starting, make sure that everyone has signed into their Office 365 account, by going to 

https://portal.microsoftonline.com or https://login.microsoftonline.com 

Start at 

:05 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 

https://portal.microsoftonline.com/
https://login.microsoftonline.com/
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Say: At the top of Office 365, you’ll find a set of links that will take you to different parts of your Office 

365 account. 

Do:  Cover basic Office 365 navigation for participants. 

1. Click on the Arrow by the Name to access Personal Settings. 

2. Click About me to change personal details. 

3. Click change to add a personal photo. 

 

 

Outlook Features 

Say: Let’s create a new message and get you working through some of the features. 

Do:  Before creating a message, give participants an overview, including working with the Folder list, 

Search window and reading pane. 

1.  New mail – Click this to create a new message. 

2. Folder list – The folder list includes the folders in your mailbox. It may include other folders, 

such as Favorites and archive folders. You can collapse this pane by clicking the folder icon at 

the top. You can expand and collapse folders in this view by clicking the triangle icons next to 

the folder names. 

3. Search window – This is where you can search for various items like the name of an email 

recipient, or keywords or phrases that appear in messages. 

Start at 

:10 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 
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4. Message list – This is a list of the messages in the current folder. Each entry in the list  

view has additional information, such as how many unread messages there are in a 

conversation, or if there’s an attachment, flag, or category associated with any messages  

in the conversation. 

5. Reading pane – This displays the conversation you’ve selected. You can respond to any 

message in the conversation by using  

 Reply, Reply all or Forward. 

Creating a New Message 

Say: And now let’s create that message, and just as a reminder, many of the activities and demos we 

work through today can be found in the Participant Handbook. This particular one is found on page 4. 

1. Click  new mail above the folder list. A new email will appear in the reading pane. 

2. To add recipients, type the name of anyone who is in your contacts folder or organization’s 

address list, or type the email address in the To or Cc field. The first time you enter a 

particular person’s name, Outlook Online searches for that person’s address. In the future, the 

name will be cached (saved in your computer’s memory) so it can be added quickly. 

3. Add a subject. 

4. Type the message you want to send. 

5. To add an attachment, click Insert. 

6. When you are done, click  Send. 

 

Creating Folders 

Say: It is very important to keep your email organized. Because Office 365 comes with so much email 

storage, you don’t need to delete your emails, but organizing them can be helpful. For example, if you 

are a secondary teacher, you may want to create folders for each of the periods you teach. Or if you 

are an administrator, you may want to create folders for various projects or initiatives that you are 

working on. 

Right-click menu for folders 

Say: Most of what you can do with a folder will be found in the right-click menu. Actions you can  

take include: 
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 Create new folder – Allows for creating a new subfolder by right-clicking the folder where you 

would like it placed. 

 Rename – Allows the folders (except default folders such as the Inbox) to be renamed. 

 Delete – Allows the folder to be moved to the Deleted Items folder. 

 Empty – Deletes everything in the folder (including any subfolders). 

 Add to Favorites – Allows the current folder to be added to your Favorites. 

 Move – Allows the current folder to be moved to a new folder. You can also move a folder by 

clicking and dragging it to the desired location. 

 Mark all as read – Allows every item to be marked as read. 

 

Say: To create a new folder, target the location in which you want to create the folder, and then right-

click its parent folder. For a top-level folder (a folder at the same level as your Inbox), use your mailbox 

as the parent folder. 

To create a folder that’s a subfolder of your Inbox: 

1. Right-click your Inbox. 

2. Click Create new folder. 

3. Type the desired name for this folder. 

4. Press Enter or click away. 

Favorites 

Say: It’s not unusual to end up with so many folders that you can no longer keep track of  

important information. 
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Make it easier to keep track of those folders by adding them to your Favorites. Favorites don’t appear 

in your folder list until you’ve added at least one folder. Adding a folder to Favorites doesn’t move the 

folder – instead it links to that folder location. 

 To add a folder to Favorites, right-click it and click Add to Favorites. 

 You can re-order folders in Favorites by clicking and dragging, or by right-clicking and then 

clicking move up in list or move down in list. 

 To remove a folder from Favorites, right-click the folder in Favorites and click remove from 

favorites. This only removes the link to the folder from Favorites; it won’t delete the folder from  

your mailbox. 

 Practice creating at least one folder for the people who contact you the most. 

Do:  Give participants a moment to try this. 

 

Other important things to remember 

 The folders you create can be at the same level as your default folders (for example, the Inbox or 

Sent Items folders). 

 You can create subfolders within any existing email folder (for example, you can create subfolders 

within your Inbox). 

 You may need to refresh your browser to view a folder that you just created in the folder list. 

 If you want to create a personal information folder as a subfolder to a mail folder, you can create 

the folder and then move it to the desired location. Some folders can't be moved to another 

location or be renamed (for example, the Inbox). If the folder can't be renamed, the Rename 

option in the menu will appear dimmed. 

Creating Rules 

Say: To help you stay organized, it can be really helpful to create and apply rules to incoming 

messages. For example, you can create a rule to automatically move all mail sent from one of your 

member groups to a specific folder. 

To manage rules, click the gear icon > Options > Organize Email > Inbox Rules. 
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The Inbox Rules tab 

Say: The Inbox Rules tab shows you an overview of all your Inbox rules. From here, you can review 

what a rule does, turn rules on or off, and create, edit or delete rules that you no longer need. 

ITEM DESCRIPTION 

 new Use this to create a new Inbox rule. 

 edit  Highlight a rule, and then click this to view or edit the details of a rule. 

 delete Highlight a rule, and then click this to delete it. 

 move up Use this to move the selected rule up in the list. Rules are processed from  

top to bottom.  

 move down Use this to move the selected rule down in the list. 

 refresh Use this to refresh the list of rules. 

On Use the check box next to a rule to turn it on (box checked) or off  

(box not checked). 

Rule The name of the rule. 

Activity (10 minutes) 

Say: Let’s try something. Imagine that I want to create a rule so that every email that comes from a 

certain person is put in the designated folder for that person. 

Do:  In pairs, have one person use the help tool in Outlook Online. Click help and then type “create rule” 

in the search box. The first article that comes up will walk you through the help. 

Use the article to help you set up the rule. 



 

 

 In the Cloud: File Storage Collaboration and Communication with Office 365 – Teacher Academy 18 

Rev. 04/21/2014 

 

 

 

 

Calendar Features 

Say: After your Inbox, the calendar is probably the next greatest asset when using Outlook Online. You 

can view your calendar in four different ways: Day, Work Week, Week, and Month. 

 

 

Student use of the Calendar 

Say: One of the most powerful uses for the calendar is as a homework planner for students. Instead of 

purchasing a planner for every student, schools are saving thousands of dollars by teaching their 

students to use the calendar and appointment reminder features to create things like study reminders 

or assignment deadlines. 

Imagine you are a math teacher and have just written the assignment for the night on the board, and 

there is a unit test next Thursday. Students should access their calendar and create an appointment at 

the appropriate time to remind them to start their homework. They should then create another 

repeating appointment for each daily timeslot over the next week reminding them to study for the test. 

After we go through the views and how to create appointments, we will practice how to add 

assignments as appointments and future tests. 
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Week View 

Say: Week view is the default view shown when you first visit your calendar in Outlook Online. You 

can change it to Day, Work Week, or Month by using the options in the upper right-hand corner. 

1. Create a new event by clicking  new event. An event can be an appointment, a meeting, 

or an all-day event. 

2. Use the calendars to navigate from one date to another. Shading indicates the week you’re 

currently viewing, and darker shading marks the current date. You can use the calendar icon 

at the top to collapse or expand this side of the calendar view. 

3. You can view more than one calendar at a time, and even create other calendars such as 

one for a specific project or to track personal appointments. You can also add other people’s 

calendars and select which one to display. If you select multiple calendars to display, they’ll be 

merged into a single view with each calendar given a different color. 

4. This is another area that you can use to navigate from one day to another. Click any date  

to jump to that date, or click the arrows on either end to see the dates before or after  

those displayed.  

5. The main window, where calendars will be displayed. Double-click any white space in this 

window to create a new calendar item, or click and drag to create a new item in the time 

you’ve selected. 

6. Select the desired view, and share or print your calendar. 
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Day View 

Say: The day view is most useful if you have a very busy schedule, or if you want to view multiple 

schedules side-by-side. The controls remain the same, only the view has changed. 

 

 

Month View 

Say: The month view can become very crowded. To make it more usable, there’s an agenda displayed 

for the selected day. 

Activity (5 minutes) 

Do:  Give participants 5 minutes to practice switching between views. Write “Month,” “Week” and “Day” 

on a board or flipchart, if helpful. Now, spend 2 minutes doing a “whip around”, where you ask the 

question, “In what circumstance might you use each of these three views?” 
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Event Details 

Say: You can click any event in your calendar to see a quick view of that event. If you created the 

event, you will be displayed as the creator and you will have a link to edit or delete the event. 

 

Say: If you’ve been invited to a meeting, you will see the organizer and links to respond to the 

invitation. If the organizer has included an online meeting invitation, you’ll see a link to join  

the meeting in the body of the invite. 

 

Views – Day/Work Week/Week/Month 

Say: The day view is most useful if you have a busy schedule, or if you want to view multiple  

schedules side-by-side. The controls remain the same; only the view has changed. Shading shows the 

current date. 

1. Current date – Indicated by the day being shaded. 

2. Selected month – Indicated by slightly lighter shading. 

3. Selected day – Indicated by the day that is shaded. The number tells how many non-

displayed items there are on each day. Double-click an item to open it, or to create a new 

event on any date by double-clicking the white space on that date. 

4. All-day event – Indicated by the item being shaded. 
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5. Agenda for the selected day – You can create a new item on the current date by double-

clicking the white space in the agenda. 

Creating Calendar Items 

Say: To open a new calendar item in any view, you can click  new event or double-click any white 

space on the calendar. In the Day, Work Week, and Week view, you can select a 30 minute block of 

time or drag to select a longer block, and then type the subject directly on the calendar. From there, 

you can double-click the new item to open it and add other details. 

Create an Appointment 

Say: Click  new event or double-click the calendar to open a new calendar item form. 

Activity 

Imagine we are students and need to create an appointment, a reminder to work on our math 

homework, adding the assignment into the details. 

1. Enter a short description of the event (i.e. Math: pg. 46, questions 1-6). 

2. Add a location (optional). 

3. Select the starting date and time (today at 5pm). 

4. Select the duration (30 min). Select All day for an all-day event. All-day events appear at the 

top of the calendar date. 

5. Use Show as to choose how you want the time to appear on your calendar. 

6. Set the reminder. For example, if a student is going to be at a friend’s house, setting a 30 

minute reminder to get home at a specific time may be helpful. 

7. If you have more than one calendar, choose and save to the appropriate calendar. 

8. Set a repeating pattern if you want this event to repeat (this is great for nightly studying for 

an upcoming test.) 
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9. Mark it as Private if you don’t want anyone you’ve shared your calendar with to see the 

details. This only matters if you have shared your calendar with others; if you haven’t, then 

nobody can see your appointment. 

10. Use the Notes area to add any other desired information. For example, if you want to be 

directed to your teacher’s website, you could add a hyperlink. 

11. Click  Save to save your changes or  Discard to cancel. 

 

 

 

Say: When checking for meeting availability of other people, Scheduling Assistant allows you to view 

available times of people in your domain. 

Create a Meeting 

Say: This is one of the most under-used features in schools and districts. People will often just send out 

an email letting everyone know that there is a staff meeting every other Wednesday from 3:15 to 4:00 

pm. A more effective strategy is creating a “meeting” and inviting the entire staff – this way, if a 

meeting is canceled or needs to be moved, everyone will receive a calendar update. 

A meeting is a calendar event that you send to other people. You create a meeting the same way you 

do an appointment, but you invite attendees and may add a resource such as a conference room. 

After you’ve selected  new event, you follow most of the same steps. To turn a calendar item into 

an invitation, start by entering the names of people you want to invite in the Attendees field. 
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1. By typing directly, the Attendees field allows you to add names to your event. 

2. Enter a location, or select Add a room to see a list of available conference rooms from your 

organization’s address book. 

3. To see the availability of attendees and resources such as conference rooms, select 

Scheduling Assistant. When you’re done, click  OK to save your changes or  discard to 

cancel. Both will take you back to the event form where you can make any other changes you 

want before sending. For more information, see Using the Scheduling Assistant. 

4. If online meetings are enabled for your account, you can add an online meeting link by 

selecting Online meeting. 

5. By default, Request responses is turned on, but you can turn it off if it’s not important to 

know who has accepted or declined the invitation. If you leave request responses on, you’ll 

receive a message as each attendee accepts or declines your invitation. 

6. Click  Send to save your changes and send the invitation to the attendees or  Discard  

to cancel. 

 

 

 

http://office.microsoft.com/en-us/office365-suite-help/redir/HA103998921.aspx?CTT=5&origin=HA102824447
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Sharing Your Calendar 

Say: With a few clicks, you can share your calendar with other people in your organization. In 

education, this is really helpful when you work in a team. 

Maybe you are on a grade-level team or a content team with 3-5 other teachers. Each of you can 

share your calendar with the others so you can see the appointments that your teammates have 

created on their own calendars. This is really useful when you are trying to plan a meeting and you 

want to see everyone’s availability. 

Start by clicking  Share at the top right side of the window: 

1. Start typing the name of the person with whom you want to share your calendar. It will 

automatically search for them in the address book. 

2. After they’ve been found, they’ll be automatically added to the list of people to share with. 

You can add as many people as you want. 

3. Choose how much information you want to share: 

a. Full details lets that person see all the information about events on your calendar, 

except events that you’ve marked as Private. 

b. Limited details will show the subject and location. 

c. Availability only shows only an event at a particular time, but no other details.  

No matter what you choose, private events will always show only as busy  

without any details. 

4. You can edit the subject if you like. 

5. If you have more than one calendar, choose which one(s) you want to share. Most people  

share their default calendar (called Calendar), but you can share any calendar that’s part of  

your mailbox. 
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6. After you’ve added everyone you want to share with and what level of access you want  

them to have, click  Send to send the sharing invitation to the people you’ve added, or  

Discard to cancel. 

 

Note:  For more information about sharing calendars, see Sharing your calendar in Outlook Web App. 

People 

Say: The People tool allows you to find people or groups in your organization. You can also add 

personal contacts and create a personal group (also called a distribution list or “DL”). 

Create a new contact by selecting  New. 

1. Add new contact. 

2. Organize contacts. 

3. Search contacts – Type a person’s name to search for them in your contacts and in your 

organization’s address book. For more information, see Search in Outlook Web. 

4. List of contacts. 

5. Contact selected –The contact card for the selected person. 

6. Actions for contact (send mail, schedule a meeting, instant message) – Actions you can take 

directly from the contact card. Select the icons to send a message, start an IM session, or 

create a meeting request. (See numbered diagram on the next page.) 

 

 

http://office.microsoft.com/en-us/office365-suite-help/redir/HA103842904.aspx?CTT=5&origin=HA102824447
http://office.microsoft.com/en-us/support/redir/HA102929994.aspx?CTT=5&origin=HA102824629
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Creating a New Contact 

Say: When you receive an email address or contact information from someone that isn’t a part of your 

organization, you can add them here. For example, if you are a teacher, you could collect the email 

addresses of students and/or parents, and store them here. 

To create a contact, select the folder under My Contacts that you want to create the contact in, then 

select  new and select Create contact. 

This will open a blank contact form. Fill in any desired details, and then select the  icon to see more 

options for that type of information. For example, if the person you’re adding to your contacts has 

multiple phone numbers, select the  next to Phone to add phone numbers. 

When you’re done, select Save to save your changes or  Discard to cancel. 
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Create a Group 

Say: You can create a personal group in Outlook Online that is stored in your Contacts folder which 

can contain entries from your personal Contacts and from your organization’s address book. 

If you are a teacher, and have collected all of your students’ and parents’ email addresses, this is where 

you can create a group so you can easily send important messages or newsletters to an entire group of 

parents and/or students. 

To create a personal group select the folder under My Contacts in which you want to create the group, 

then select  new and select Create group. 

This will open a blank group form. Enter the desired group name and any notes. To add members, type 

the name of the desired person to add in Members. 

Outlook Online will search for a match in your Contacts and in your organization’s address book.  

If a match isn’t found, you can search for that person. You can also type an email address directly  

in Members. 

Press Enter to add your selection to the group. 

When you’re done, select  Save to save your changes or  Discard to cancel. 

 

Creating a Contact from a Message 

Say: Too often, when you collect parent and student email addresses using a form parents fill out, 

mistakes can be made, or handwriting can be difficult to read. An even better way to collect parent 

and student email addresses is to have them send you a quick email from their email and then create 

a contact from that message. 

To add a contact from a message:  

1. Click on the name/email address of the person who sent you the email. 

2. A new card appears. Click on the Add to contacts link. 

3. Add any additional information you want. 

4. Select  Save to add the card to your Contacts, or  Discard to cancel. 
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Practice (approximately 2 minutes) 

Do:  Have each participant partner up with someone near them, then email each other and practice 

creating a contact from that message. 

Say: Before we go on to the “Turn and Talk” section, please take a look at the additional resources 

available for Office 365, starting on page 4 of your handbook, end ending on page 8, with details 

about this next activity. 

Turn and Talk 

Display Slide 5: Turn and Talk 

Do:  In groups of two or three, have participants turn to each other and discuss their ideas for what 

implementation and integration of Outlook would mean for their school or district. 

Promote ideas such as: 

1. Collaboration: How will Outlook promote collaboration? 

2. Decision Making: How will Outlook be used in your district/school? 

3. Planning: Careful planning is essential when training. What will you take into consideration as 

you train on Outlook? 

Share 

Display Slide 6: Share 

Do:  Have one or two people share which features from this training session they are most excited about 

using in Outlook. 

Section #3: Office Online (1 hour, 30 minutes) 

Objectives: 

 Introduce Office Online & OneDrive for Business, discussing the features that are available 

 Give participants the opportunity to discuss and strategize on how Outlook could be integrated 

and implemented at their school or district 

Introduction 

Display Slide 7: Office Online 

Note:  Before starting, make sure everyone has signed into their Office 365 account, by going to 

https://portal.microsoftonline.com or https://login.microsoftonline. 
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Say: Now let’s take a look at OneDrive for Business & Office Online. At the top of Office 365, you’ll  

see a set of links that will take you to different parts of your Office 365 account. Let’s start by clicking 

on OneDrive. 

 

OneDrive for Business & Office Online Features 

1. Tabs for Files & Library. 

 

 
 

2. You have quick access to My Documents and any document shared with you by clicking on 

one of the corresponding links. You can also see any recent document near the bottom of 

that section. 

 

Start at 

1:40 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 
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3. By clicking on new document you can choose between creating a new Word, Excel, 

PowerPoint, OneNote, or Excel Survey. You can also drag any existing files to the area to 

upload them. 

 

 
 

 
 

4. You can search for your files in OneDrive for Business, and also click on the ellipses (…) to 

create a different view. 

5. When viewing the listing of files, you can click on individual ones to share or manage. 
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Office Online 

Say: To create a new document: 

1. Click on  new Document to choose what type of file you need or you can create a folder 

to organize your files. 

 

2. Click on your program of choice to create a file. You must name the file because it will save to 

OneDrive for Business. 

 

3. Once the document opens, you will see that your new file is identified as Online. 
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4. Go to the top of the page if you need to open the document in the client version of Office 

on your device. 

 

5. Remember that when you click save, it is saving to your OneDrive for Business. 

Activity (20 minutes) 

Do:  Have participants get into groups of four. One person is in charge of Word Online, one is Excel 

Online, one is PowerPoint and one is OneNote.  

 Basic tasks in Word Online 

 Basic tasks in Excel Online 

 Basic tasks in PowerPoint Online 

 Basic tasks in OneNote Online 

Each person has 15 minutes to read through their assigned support topic (have them refer to page 10 of 

their handbook). Afterwards, each person gets 5 minutes to share their “new learning” with the group. 

They should only pick ONE of the reading topics to share. 

Managing a File 

1. Go to the document library you want to share from, click the ellipses (...) next to the 

document to open the document’s callout. 

 

 

http://office.microsoft.com/en-us/office365-suite-help/redir/HA102843651.aspx?CTT=5&origin=HA102619009
http://office.microsoft.com/en-us/office365-suite-help/redir/HA102843654.aspx?CTT=5&origin=HA102619009
http://office.microsoft.com/en-us/office365-suite-help/redir/HA102843659.aspx?CTT=5&origin=HA102619009
http://office.microsoft.com/en-us/office365-suite-help/redir/HA102843655.aspx?CTT=5&origin=HA102619009
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2. After you click on (…) you will see who has been granted sharing permission. 

 

3. Click on the other (…) and you can manage the document which includes editing, viewing, 

downloading, sharing, and deleting your file on OneDrive for Business. 

Sharing a Document 

1. Locate the document library to be shared, and click the ellipses (...) next to the document to 

open the document’s callout and then click Share. 

 

2. In the Share window, enter the name (email) of each person you want to invite to share the 

document. As you type each name, SharePoint searches the address book for matches and 

lists options. When you see the desired name, click to add it to the invitation list. 

3. Select the desired permission to grant invitees from the drop-down menu. You can  

change the permission for any person later. If desired, type a message to be sent to all 

invitees in an email, which will also automatically include a link to the shared document.  

If you do not want to send an email, click Show Options, and then uncheck Send an  

email invitation. 
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4. The other option for sharing is Get a Link, which allows you to create a link for a view only 

document that you can send to someone. 

5. You can also create a link that allows the user to edit the document. 

Receiving a Shared Document in Email 

1. Click the document link in the email you received informing you that a co-worker has 

shared a document with you. 

2. If you have been granted edit permissions, check out the document (if edits are needed) 

and edit the document in Word, PowerPoint, or another Office program. If you don’t have 

edit permission, editing will not be possible. 

a. If you have only been granted view-only permissions, save a local copy of the file to 

your computer and make/save any edits separately. 

3. Click File > Save to save your changes. 
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4. To “Review a Document” that someone has shared with you: 

a. Click the document link in the email you received informing you that a co-worker 

has shared a document with you. 

b. Review the read-only document and if needed, save any work in a  

separate file. 

5. If you don’t have edit permissions, save your notes and edits to a separate file, and send a link 

to the document you created to the original document owner and any others who are 

collaborating with you. 

 

See Who You’re Sharing With 

1. Select a document and click Files > Shared With. 
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2. The Shared With window lists all the people currently sharing this document and their 

permission status. 

Stop Sharing a Document or Folder 

1. Select the document or folder you want to stop sharing, and then click Files > Shared With. 

2. The Shared With window lists who’s sharing the document. Click the drop-down arrow next 

to the person you want to stop sharing with, and then click Stop sharing.  
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Sending an Email to Shared Document Recipients 

Say: You can quickly address an email to everyone who has received a shared document from you. 

You might do this if there are details about the document you want them to know about, or if you 

want to remind them that you’ve shared a document with them. 

1. Select the relevant document, and then click Files > Shared With. 

2. In the Shared With window, click Email Everyone. 

3. If prompted, click Allow in the Security Warning dialog box to allow SharePoint to open 

your email program. 

4. Compose and send the email from your email program. 

Turn and Talk 

Display Slide 8: Turn and Talk 
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Do:  In groups of two or three, have participants turn to each other and discuss their ideas for what 

implementation and integration of OneDrive for Business and Office Online would mean for their school 

or district. 

Promote ideas such as: 

1. Collaboration: How will OneDrive for Business & Office Online promote collaboration? 

2. Decision Making: How will OneDrive for Business & Office Online be used in your 

district/school? 

3. Planning: Careful planning is essential when training. What will you take into consideration as 

you train on OneDrive for Business & Office Online? 

Share 

Display Slide 9: Share 

Do:  Have one or two people share which features from this training session they are most excited about 

using in OneDrive for Business Office Online. 

Lunch (30 min.) or Break (15 min.) 

Note:  All times listed in this trainer guide are based on a 15 minute break at this point of the Academy. 

This break is part of the six hours, and the lunch is not. Please plan accordingly, adjusting times for when 

it makes the most sense for everyone. 

Section #4: Lync (1 hour, 30 minutes) 

Objectives: 

 Introduce Lync and discuss the features that are available 

 Give participants the opportunity to discuss and strategize on how Lync could be integrated and 

implemented at their school or district 

Introduction 

Display Slide 11: Imagining Lync Scenarios 

Say: Imagine that you are a high-school art teacher in a school district that has many schools, spread 

across many miles. In your district, you have early-release collaboration time and get 75 minutes every 

Wednesday to collaborate with other art teachers. Previously, you would all meet at a centrally located 

school, but it took up to 30 minutes for some of the teachers to even get there, leaving only 45 minutes 

to collaborate. 

You now have access to one of the most powerful collaboration tools: Lync. Now, when your team of 

art teachers meet, instead of leaving school, you have created an Online Meeting that you all join from 

your computer. When combined with screen sharing and OneNote, you can collaborate together, and 

make full use of all 75 minutes. Today, all of you are meeting in a large online meeting and then 

dividing up into small groups to work on various curriculum pieces. With Lync, it is easy to move 

between large and small meetings at any time. 

Start at 

3:20 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 

Start at 

2:55 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 



 

 

 In the Cloud: File Storage Collaboration and Communication with Office 365 – Teacher Academy 40 

Rev. 04/21/2014 

 

Or… 

Imagine that you are a middle school student who is home working on solving equations when you 

get stuck. Fortunately, you have added your friends to your Favorites group in Lync and you can see 

that your friend, Alex, is online right now. You quickly send an instant message asking Alex if he has 

time to help you on the homework. Within 30 seconds, you are in a web call. You share your desktop 

with Alex so he can see what you are working on. As you work through the problem, using your stylus 

and OneNote, Alex sees where you are going off track and helps you understand the mistakes you  

are making. 

These are just two examples of how Lync will dramatically change the way you collaborate and work 

in teams so that you and your students can be more efficient and effective. Let’s dive into downloading 

and installing Lync (if it isn’t already installed), and then we can move into hands-on exploration. 

Note:  Make sure you have downloaded the Lync client from Office 365. Participants will also need 

webcams and headsets with microphones. 

1. Click on the gear icon next to your name, then click on Office 365 settings. If you have it 

installed on your work device, you can also follow these same steps to install Lync on your 

home computer. 
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2. Next, select software to manage and install software for Office 365. 

 

3. Select Lync from the software list. Click Install the latest version to install the Lync client  

to your computer. After the install completes Lync will launch and the icon will appear in  

your taskbar. 

 

4. Open Lync by clicking on the icon, as it should now be ready to use. By default, Lync will 

launch each time you start up and log into your computer, so you don’t need to remember to 

launch it each day. 
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Getting started with Lync 

Say: If you haven’t already logged in, let’s do so to access your Office 365 account. Once logged in, you 

will see the Lync interface. Let’s begin by getting Lync set up with more customized options. 

Options & Tools 

Options 

Say: To select the optional settings for Lync, follow these steps: 

1. Select Tools on the top menu. 

2. Select Options in the next menu box. 

As with all Microsoft products, there are a variety of different ways to get to these options. Please be 

sure to explore the options not covered in this training today or in the future. 

Do:  Offer any other options that you may be able to share (based on your experience.) 
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Tools 

Tools > Options > Audio Device 

Say: Using Audio Device allows you to select which speaker or microphone you want to use with 

Lync, or what output level you want to use for your speaker, microphone, or ringer. 

 

Tools > Options > Video Device 

1. Video Device – Allows you to select which camera to use with Lync. 
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2. Webcam Settings – Allows you to control how the camera reacts. 

Tools > Options > My Picture 

Say: My Picture allows you to select the picture for your profile. If you uploaded a picture to your 

Office 365 profile, set your Lync picture as the corporate one. After a short wait, it will automatically 

be set to the same picture. Sometimes, your organization will preload the pictures for you. 
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Tools > Options > Personal 

1. Personal allows you to select how Lync operates, including what you would like saved, as well 

as how Lync should appear on your monitor. 

2. It also allows you to share your location with others. 

Tools > Options > Status 

Say: This option allows you to select how many minutes before you are listed as inactive, or how many 

minutes are allotted before you are listed as away from your computer. 



 

 

 In the Cloud: File Storage Collaboration and Communication with Office 365 – Teacher Academy 46 

Rev. 04/21/2014 

 

Activity (5 minutes) 

Do:  Give participants 5 minutes to browse and discover other options that are available. 

Daily Message (Status) 

Say: You can post a message or status, changing it daily or whenever desired. 

If you are a teacher, maybe your status will be the learning targets for the day! If you are an 

administrator, you could post if you are in the office, or out at schools. Or, just leave a fun message or 

a favorite quote for everyone to read. 

 

Presence (Availability) 

1. By default, your availability will show based on what you are doing. However, you do have the 

power to override the system and post whatever availability you would like your colleagues 

and students to see. 

2. A great question to consider: Did you know that if you have a calendar appointment on your 

calendar, your status will show as “busy?” 

3. Click the Available menu then click your desired status; or click Reset Status to let Lync set it 

automatically, based on your activity and Microsoft Outlook Calendar. 
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Available 

You are online and available to be contacted. 

 

  

Busy 

You are in a Lync call, or, according to your Outlook Calendar, 

you are in a meeting, and don’t want to be interrupted. 

 

  

Do Not Disturb 

You don’t want to be disturbed (you will see conversation alerts 

if they are sent by your Workgroup contacts.) 

 

  

Be Right Back 

You are stepping away from the computer for a few moments. 

 

  

Appear Away 

Your computer has been idle for a period of time  

(15 minutes by default).  

 

  

Off Work 

You are not working and are not available to contact. 

 

  

Offline 

You are not signed in. You’ll appear Offline to individuals 

whom you have blocked from seeing your presence. 

 

  

Unknown 

Your presence is not known. Your presence might appear 

unknown to others who are not using Lync as their instant 

messaging (IM) program. 

Contacts - Add a contact by using search 

Say: You can easily message anyone in your organization, but it is a good idea to create groups and 

add the people you contact the most to your favorites. You might want to favorite your teammates 

and your supervisor. If you are a student, you might want to favorite your teachers and friends. Also, 

as a student, you might want to create a group that contains other students working on a project with 

you for class. 

1. In the search box of the Lync main window, type the name or email address for the contact 

to add. While you type, the search results start appearing below the search box. 
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If you’re trying to add an external contact and don’t see their name, try adding them by using 

the Add a Contact icon instead. This is addressed in the next section. 

 

2. In the search results, point to the picture of the person you want to add, and then click the 

More Options button. 

Note:  You can also create groups of users you want to contact by right-clicking and selecting Create 

New Group. 
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Activity (5 minutes) 

Do:  Give participants 5 minutes to add colleagues to their Favorites and to create a new  

group for these added colleagues. 

Add a Contact by Using the Add a Contact Icon 

Say: To add a contact at your organization: 

1. In the main Lync window, click the Add a Contact icon  > Add a Contact in  

my Organization. 

2. Type the person’s name or email address in the search box. 

3. Right-click the listing, and click Add to Contacts List, selecting a group for your contact. 

4. (Optional) – To view or change the privacy relationship, right-click the contact’s listing, click 

Change Privacy Relationship, and if desired, highlight and select a new one. 

 

Say: To add a contact outside your organization: 

1. In the Lync main window, click the Add a Contact icon  > Add a Contact Not in  

my Organization.  
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2. Click Lync, or, for Skype contacts, click Other Contacts. 

3. Click the IM Address box, and type a correctly formatted IM address for your new contact. 

(You’ll know that the address is correctly formatted when you see a green check mark to the 

right of the address.) 

4. Click the Add to contact group list, and select a group to add your new contact to. 

5. Click the Set privacy relationship list, and select a privacy relationship for your new contact. 

6. Click OK. 

Note:  (Important) If the contact you’ve added shows “Presence unknown,” wait for 24 hours. If the issue 

remains, or if you have any other issues with contacts, contact your workplace technical support. 

Say: Right-clicking on the group or the individual person’s name will give you a menu of choices. You 

can start a video call by selecting video call. 

Note:  If you right-click on the group and select video call, you will start a call with everyone in the group. 

 

Say: OK…back to our scenarios from earlier. Remember the art teacher who is now using Lync to 

collaborate with her colleagues during early release time? Well, she created a group so she can quickly 

IM (or call) all of them at once. The student added his friends as favorites so he can easily see their 

presence and know if someone might be available to help. 

Communicating with IM 

1. Double clicking on a contact will bring up an instant message window. You can also right-

click contact and choose the IM icon. 

2. After you type your message, press the enter key to send the message. To move to the next 

line without sending the message, hold the shift key and press return. 
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3. If the text is too small to read, you can change the size by clicking the ellipses (...) in the 

bottom right corner and selecting IM Text Display Size. 

 

End a Call or Chat Session 

 To end a call click the Icon. 

  
 Or click the red X button on the top of the window to close the window. 

 

Activity (5 minutes) 

Do:  Form groups of four, and one at a time, practice sending an instant message to each other. 

Starting a Meeting 

Say: To start a Lync meeting on your own simply go to the “gear” icon in the upper right-hand corner, 

then select Meet Now. 
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Inviting Others to a Meeting (Ad Hoc Meeting) 

Say: To add another person to your meeting, select the “people” icon in the quick Lync bar, located at 

the bottom of your Lync meeting window, then select Invite by Name or Phone Number. You can also 

drag and drop contacts from the main Lync window into the meeting window to add them. 

 

Answering a Call 

Say: To answer a call, just click on the phone icon or select one of the redirect options. 

 

Using Lync for Calls 

Say: When you are making a call, you have some icons that will give you more options for your call: 

1. You can IM or instant message while in a Lync call. 

2. Mute and unmute your microphone. 

3. Display or hide your video (if you have a webcam). 

4. Display or hide the stage (what you choose to display to participants). 
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5. Add more contacts into your call. 

6. Hang up by clicking the phone icon. 

Check Status During a Call 

Say: When you initiate or join a Lync call, be sure that you check the following three items to ensure 

that you are able to fully communicate: 

1. Your IM option is selected so that you are able to see any IM conversations that are 

occurring. It is also a good location to drag and drop new Lync participants who you want to 

join your call. 

2. Your microphone is not muted. 

3. When you are ready, add your video feed so participants can see you when you speak. 

Beginning a Meeting 

Say: When entering a Lync meeting, attendees have the default setting of their microphone being 

muted, and their web camera not being active. This is a common best practice so that video 

conference participants may prepare before they are actively contributing to the video conference. This 

means that in order to begin communicating with other Lync participants you will need to select 

sending video and or audio. 

1. To un-mute your microphone, select the microphone icon in the lower left corner of your 

Lync meeting window. This toggle switch will mute or unmute your microphone as needed. 
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2. To begin sharing a video feed, select the Video icon at the lower left, third icon from the left 

in your Lync meeting window, then select Video Cam (toggles video on and off). 

Activity (5 minutes) 

Do:  Have participants practice by partnering up with three other people in the room. One at a time, have 

them practice starting an ad-hoc meeting, adding the others to the meeting and then un-muting. They 

should also try out video. They should always remember that once they join a meeting, they will need to 

un-mute. 

Note:  You will want everyone to have headphones for this activity or there will be a cacophony of 

echoes and squeals from everyone’s microphones picking up everyone’s calls. 

Attach File 

Paperclip icon 

Say: If you would like to attach a document for participants to download, follow these steps: 

1. Right-click on the white board icon in the lower left-hand corner of your  

conversation window. 

2. This will open a pop-up window. Select Attachments, then click the paperclip. 

3. This will then bring up a document navigation window that may be used to select the 

document you would like to attach. 
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Note:  When you are viewing Lync in the full screen option, you will not see a notification that you have 

the option to download an attached file sent by another participant. 

When you return to a normal view, you will see a notification that an attached file has been added to the 

conversation and may be downloaded. 

To quickly return to a normal view from a full screen view, select the escape Esc key on your keyboard. 

Sharing 

Say: Lync allows you to share your screen (desktop), PowerPoint presentations, polling and a  

common whiteboard. To do so is as easy as clicking on the share button and then choosing the 

appropriate tools. 

Activity (5 minutes) 

Do:  Have participants practice by partnering up with one other person in the room. Start a call,  

then practice sharing a file and sharing their desktop. Everyone should be able to answer these  

two questions: 

1. How do you accept a share? 

2. How do you give control to the person to “drive” your device? 

Record Meeting 

Start recording 

Say: In order to start recording a Lync session follow these steps: 

1. Choose the ellipses (…) in the lower right corner of the conversation window. 

2. This will bring up a menu list with one of the options listed as Manage Recording. Select 

Start Recording to initiate Lync recording. 

3. Once you’ve started recording, you will see a notification at the bottom of your conversation 

window stating that you are now recording. 

4. You will also have controls to pause or stop the recording. 

5. Other Lync participants will receive a notification stating that the Lync session is  

being recorded. 
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6. When you stop recording, a pop-up window will appear that will allow you to name your 

recording and select OK, or go directly to the Manage Recording area. 

 

Manage Recording 

Publish – to select content options for video 

Say: Get to the Recording Manager by: 

1. Selecting the options icon gear. 

2. Selecting the Tools option. 

3. Selecting the Recording Manager option. You may also get to the Recording Manager as 

described previously, by selecting the Manage recordings button instead of the OK button 

when you stop a recording. 

Say: When the Recording Manager window pops up, you will have the option to play your recorded 

Lync sessions. You may also publish them as a .wmv format for editing. 
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Signing Off 

Say: In order to sign off, just select the phone icon in the upper-right corner of the Lync meeting 

window. This will stop your current Lync session. You may rejoin the video conference, or you may 

close out the window. 

 

Activity (5 minutes) 

Do:  Have participants partner up with one other person in the room. Have them start a call and then 

practice recording the session. Have them answer this question: 

 Where does the recording save when you are finished? 

Making a Lync Appointment 

Say: Now we’ll talk about creating an online meeting and setting the meeting options. To schedule a 

Lync meeting follow these steps: 

1. While using the calendar view in Microsoft Outlook, go to the Home tab and then select New 

Lync Meeting. This will allow you to create a scheduled Lync meeting. 

2. A meeting window will appear, that will allow you to select meeting participants and the 

meeting time. You will also have the option to customize the Lync meeting by selecting 

Meeting Options. 
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3. When it is time for the meeting, participants will be able to join the meeting from their 

reminder pop-up, from the Join Lync Meeting button (3A), or from following the line of 

hyperlinked text (3B). 

 

4. When customizing a meeting using the Meeting Options button, you will get a pop-up 

window allowing you to set parameters for the meeting while acting as the meeting organizer. 

This will allow you to determine which people can enter the Lync meeting directly, or which 

people will need to wait in the virtual lobby until they are admitted. You will also be able to 

determine who will be presenters and who will be attendees to the meeting, which will 

influence their permissions to perform certain tasks. 

 

Note:  If you are using Outlook Web Access through your browser, you can create a new appointment 

and then copy and paste the Lync meeting information into the notes of your calendar appointment. To 

do this, start a Meet now meeting and then at the top, click the Join Information and Meeting 

Options link. You can then copy this information into your new calendar appointment. 
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Activity (5 minutes) 

Do:  Have participants partner up with three other people in this room. They should practice creating an 

online meeting and invite the other three, then practice joining the meeting using the link found in the 

Appointment details on their calendar (they can still join a meeting even if it isn’t the correct time.) 

Sharing Documents from Other Applications 

Say: While in an Excel, PowerPoint or Word document you may immediately share that document 

with someone on Lync without having to go to Lync and initiate a Lync call. Follow these steps to 

immediately share documents: 

1. Select the File tab and select one of the following two options. 

2. Share > Present Online – This allows the user to initiate an IM conversation while screen 

sharing the document. This means that the document will still be on your computer, but the 

other person will see it, and may make changes if you give them permission. 

3. Share > Send by IM – Allows the user to send a copy of the document, and initiate an IM 

conversation at the same time. This means that you will be sending a copy of the document 

to the person that they will be able to download for their own use. 

 

 

Say: Names in Outlook and a SharePoint portal are attached to your contact information in Lync. 

When you hover your cursor over a name or right click the name, Lync information will appear. This 

will allow you to choose command selections such as: 

 Send an email to that contact. 

 Send an IM to that contact. 

 Initiate a Lync call with that contact. 

You may also: 

 Start video call. 

 Schedule a meeting. 

 Share your desktop. 
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 Tag for Presence Alerts (i.e., to see when someone changes from “Offline”  

to “Available”). 

Turn and Talk 

Display Slide 12: Turn and Talk 

Do:  In groups of two or three, have participants turn to each other and discuss their ideas for what 

implementation and integration of Lync would mean for their school or district. 

Promote ideas such as: 

1. Collaboration: How will Lync promote collaboration? 

2. Decision Making: How will Lync be used in your district/school? 

3. Planning: Careful planning is essential when training. What will you take into consideration as 

you train on Lync? 

Share 

Display Slide 13: Share 

Do:  Have one or two people share which features from this training session they are most excited about 

using in Lync. 

Section #5: Yammer (1 hour, 5 minutes) 

Objectives: 

 Introduce Yammer and discuss the features that are available 

 Give participants the opportunity to discuss and strategize on how Lync could be integrated and 

implemented at their school or district 

Introduction 

Display Slide 14: Yammer 

Say: Now we’re ready to talk about Yammer. Your system administrator should have your Yammer 

site created. 

With Yammer, you’re always connected to coworkers, information and conversations. Tap into your 

network to find exactly what you need and discover things you didn’t know to quickly make decisions, 

get work done and keep moving. 

Start at 

4:50 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 

Start at 

4:35 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 

Start at 

4:40 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 
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Note:  Before getting started, make sure everyone has signed into their Office 365 account, and have 

webcams and headsets with microphones ready to go. 

 

Ready to Use 

Say: Yammer is a great tool for staff or student use. Schools can create Yammer groups for the staff so 

they can have a virtual bulletin board to post ideas or requests. When a decision needs to be made, 

you can engage the polling feature. Because the groups are closed, you don’t have to worry about 

people outside the group potentially seeing and contributing. 

For students, it allows schools to expand problem-based learning (PBL) opportunities, where students 

look up answers to questions and share information with the group, rather than memorizing lectures. 

With a classroom Yammer group created by the teacher, students have a place to connect to each 

other. Teachers can communicate with all students, events can be scheduled or virtual office hours can 

occur. Information, notes and examples can easily be posted for all students to see. 

Updates can be made to share announcements or reminders. They can also be used for students to ask 

questions that can be answered by the instructor and/or fellow students. 

Info can be edited by the teacher to add links to important documents, lists of useful tools, and/or 

anything else that improves the efficiency of classroom learning. 

Files can be uploaded directly to your classroom group and students can upload files for the teacher or 

fellow students. This is useful for organizing assignments. 

Pages can be created to gather and share policies, ideas, notes, and other information with your class. 
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Yammer Features 

Say: Let’s spend some time editing your profile, uploading your photo, sharing your expertise, and  

finding coworkers. 

Clicking on each topic to the left opens a new fillable form for you to input as much or as little as you 

wish to share about yourself and your interests. 

Activity (10 minutes) 

Do:  Give participants 10 minutes to practice updating their profiles. Encourage them to find co-workers 

in the room and “follow” them. 

Start at 

4:55 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 
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Create Groups 

Say: Yammer presents a flexible, collaborative workspace for teams to get work done, discuss projects, 

share files, and gather feedback. 

 

1. Consider whether your group will be exclusively available to people in your internal 

organization, or if also available externally. 

2. Every group needs a Group Name. 

3. Select members from your group by name or email. 

4. Decide who can view any content you may post. 

5. Create your group. 



 

 

 In the Cloud: File Storage Collaboration and Communication with Office 365 – Teacher Academy 64 

Rev. 04/21/2014 

 

Edit Group Settings or Delete a Group 

Say:  You can adjust group settings while you are in a group by clicking on the gear icon next to the 

group name. 

 

1. Upload an image to use for the group. 

2. Change the name of the group. 

3. Add members. 

4. Add other people to become administrators of the group with you. 

5. Remove members. 

6. Send an announcement to the whole group. 

7. Change whether the group is public, private, listed or unlisted. 

8. Determine who can join the group. 

9. Save your changes. 

10. Delete the group (you would potentially use this option at the end of each year if you are a 

classroom teacher using this with your class). 
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Follow people 

Say: Whenever desiring to see all posts from a colleague, be sure to follow them. Then, if you choose to 

filter your news feed, you will see only the people you follow. We’ll show you filtering shortly. 

To find people to follow, click on the ellipses (…) in the upper right corner and select People. This will 

show you everyone in your network, and you can then choose who you want to follow. 

Students will probably want to follow their teachers. 

 

 

Activity (10-15 minutes) 

Do:  Give participants 10-15 minutes to practice creating and adding people to a group. They should 

break up into groups of 6 and have one person invite everyone to a group they have created. Have 

another person create a group and have the other 5 practice finding it and requesting to join the group. 

1. Click on the Groups link on the left-hand column of the home feed page, then the group can 

be located by clicking on the first initial letter of that group. 

Built around communication 

Say: Built around communication, Yammer is where people work transparently and conversations 

happen in private, only when appropriate. This way, everyone experiences the optimized benefits of 

this shared information tool. 
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1. Select a group and post a new discussion thread or join one in progress. 

2. Share a file with the group. 

3. Share notes about a project or idea. 

4. Add members. 

5. Post an announcement. 

6. See the other group members. 

 

Note:  You can adjust the “news feed” so you only see the people you are following, top feeds, or 

everyone in the network. 

Say: If you don’t have a group selected when you start posting, you can choose which group is allowed 

to see your post.  
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Activity (10-15 minutes) 

Do:  Give participants 10-15 minutes to practice posting a message, sharing a file and viewing other group 

members using one of the groups that they just created. 

Stay Organized with Your Inbox 

1. Keep conversations with your Inbox, a single place to follow the @mentions, group 

announcements, conversations and your private messages. 

2. Track the messages that need immediate responses in Priority Messages. 

3. Save others to read later in Unread Messages. 
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Posting a Poll 

Say: If you are a teacher who uses Yammer with your classroom, the Poll tool can be a fantastic  

entry or exit ticket. Imagine that you have assigned homework to your students – you could select  

one of the problems and ask the students to vote on which one they think is the correct answer as  

they enter class. 

 

Yammer While Mobile 

Say: Get a link so you can download Yammer and continue conversations from anywhere using  

your smartphone. 

https://about.yammer.com/product/mobile/ios/ 

 

Turn and Talk 

Display Slide 15: Turn and Talk 

Do:  In groups of two or three, have participants turn to each other and discuss their ideas for what 

implementation and integration of Yammer would mean for their school or district. 

Promote ideas such as: 

1. Collaboration: How will Yammer promote collaboration? 

2. Decision Making: How will Yammer be used in your district/school? 

3. Planning: Careful planning is essential when training. What will you take into consideration as 

you train on Yammer? 

Start at 

5:40 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 

https://about.yammer.com/product/mobile/ios/
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Share 

Display Slide 16: Share 

Do:  Have one or two people share which features from this training session they are most excited about 

using in Yammer. 

Section #6: Closing (5 minutes) 

Objectives: 

 Summarize learning goals and achievements 

 Answer any remaining questions 

Q&A 

Display Slide 17: Q&A 

Do:  Answer any questions from the participants. 

Promote Additional Learning 

Display Slide 18: Teacher Academy 

Say: I hope you’ve enjoyed today’s Teacher Academy and that you take the skills you learned today 

and use them in your classrooms. 

Do:  Mention any other Academies available. 

Appendix 

Before You Train 

In order to deliver a quality training experience to educators, we have a list of questions the district will 

want to review. The district will also need to ensure necessary set-up has been completed prior to the 

delivery of the Academy titled, In the Cloud: File Storage, Collaboration, and Communication with 

Office 365. 

Please review the items on the next page. If you believe the district is not quite ready for this training to 

be offered, please send an email to, pilsup@microsoft.com as soon as possible. 

 

Thank you.  

  

Start at 

5:55 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 

Start at 

5:58 

 

Start at 
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Start at 

:00 

 

Start at 

:00 

Start at 

5:45 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 
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Items to Consider for Office 365 District Startup 

 

1. Implementation timeline for Office 365 Services in the school/district: 

a. IT Department has their instance and has setup Office 365 services. 

b. Accounts are created. 

c. Email addresses/passwords have been issued to users. 

d. (If these items can be checked then on to Item 2.) 

2. Office 365 services to be used immediately or scheduled rollout and for which populations: 

 

Service Available When Population Training 

Priority 

Email 

 

(Immediately, 

Year 2, etc.) 

(Admin, Teachers, 

Students) 

 

Lync  

 

   

OneDrive for 

Business 

 

   

Team Sites 

 

   

Yammer 

 

   

 

Districts will want to have a plan that spans beyond email deployment and OneDrive for Business. 

Please be sure to design or review your plan for all services available. It is important to plan which 

services are needed and how they work together. 

You should also refer to the pre-training notes section in this guide for additional details on setup, 

software and accounts. 


